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Getting Started

You can run Altamira Composer at various resolutions, but for these tutorials, we assume a display 
resolution of 800x600. If you use a larger display, the tutorials will work fine but appear smaller in the 
view window. If you use a 640x480 display, you may need to pan the view every so often.

Each step in the tutorials is either numbered or bulleted. Two or more steps look like this:

1. From the Files menu, select Compositions, and then select Open Composition from the 
submenu.

Result: The Open Composition dialog box appears.

2. Enter a filename and click on OK.

Single steps look like this:

o Click Delete    to remove the image.

Most of the functions you use in Altamira Composer are located at the top of your 
screen in two general areas:

o The drop-down menus contain all of the program's functions. 

o The two rows of tool bars beneath the menus contain most of the menu functions.

The left half of the lower tool bar contains 13 swap buttons. You can access different groups of swap 
buttons by right-clicking anywhere over the tool bars. 

These tutorials specify the tool bar buttons, unless a function exists only in the menus. The tutorial steps
name the button function. In addition, the name of the function is displayed by the mouse cursor when 
you point to the tool bar button.



Tutorial 1

Daisy, Daisy

Altamira Composer uses a new concept called Dynamic Alpha that provides transparency to the pixels 
in your raster images. In turn, this transparency provides smooth, anti-aliased edges and lets you work 
with multiple images as if they were objects. With this technology, you can compose your pictures using 
multiple images-like a collage.

Setting up a composition
Loading an Image
Adjusting the composition guide
Creating a locked background
Multiple image libraries
Selection Sets
Putting the flower in the hat
Setting the Spline Options
Creating the Spline Mask
Creating a Shadow
Color Selection
The Color-Atop Command
Positioning the shadow
Adding Transparency
Using Blur and Erase
Adding Text
Creating a Ramp (or gradient)
Using the Texture command
Aligning Images
Automatic Drop Shadow
Going Home
Saving a Composition
Clearing a Composition



Setting Up a Composition
 
You'll begin by establishing a new composition, and then loading a picture that was taken from a Kodak 
PhotoCD (tm) disk. You'll use the picture to create a composition for what could become a book or 
magazine cover.
 
1. From your Windows desktop, double-click the Altamira Composer icon to run the program.
 
2. Click the Windows maximize buttons in the Altamira Composer window and in the View 1 window 
to enlarge them to full size.
 
3. Select the File menu, and then click on New Composition.
 
Result: The New Composition dialog box appears.
 
Note:    If you've been using Altamira Composer before starting this tutorial, a message first appears 
asking if you want to save the current composition. Answer No, unless you want to save your work, in 
which case you should answer Yes and enter a filename in the resulting file dialog box.The New 
Composition dialog box contains various options. You could simply accept the default values in the 
dialog box, but for the sake of example, you'll create a composition size that's smaller than your current 
view window.
 
4. In the Width field, enter 600; in the Height field, enter 400.
 
5. Click on OK.
 
Result: A light gray rectangle appears in the darker gray background of the view window. 
The light gray rectangle is called the composition guide. As its name implies, it's only a guide to give you
an idea of the size of your composition. It's one part of the area seen through your view window, all of 
which is called the void. You can place and arrange any number of images anywhere on the void, 
regardless of the size of the composition guide. However, when you print your composition, only the 
images on the composition guide are printed. In addition, the upper-left corner of the composition guide 
specifies the origin, or beginning of the Altamira Composer coordinate system. Thus, the x coordinates 
begin at 0 at the upper-left corner of the composition guide, and move in a positive direction to the right, 
and a negative direction to the left. The y coordinates likewise begin at 0 in the upper-left corner and 
move in a positive direction downward, and a negative direction upward.
 
Your composition guide can be any color. Here's how to change it:
1. From the Options menu, select View Options.
Result: The View Options dialog box appears.
2. In the list window at left, click to select Composition Guide Color.

You'll make a white composition guide.
 3. Enter 255 in each of the RGB (red, green, blue) fields, and then click on OK.
 Result: The composition guide turns white.





Loading an Image 

 
Now you can load the first image:
 
1. In the top tool bar, click the Open Image    button.
 
Result: A file dialog box appears.
 
2. Use the file dialog box to access the composer\images directory.

o Use the List Files of Type drop-down menu to select JPEG images (*.jpg).

o Select and load: model.jpg.
 
Result: A picture of a model wearing a red hat appears in the upper-left corner of your View window.

The picture you've just loaded is an image, which is the basic component that makes up a composition. 
You can have any number of images in your composition, and each is a 32-bit raster picture. The term 
32-bit means that 24 bits of data describe the red, green, and blue (RGB) of each pixel in the image, 
while 8 bits describe the pixel's alpha transparency. (The term pixel is short for picture element, and 
refers to the smallest changeable element in a picture.)
Images are either loaded into a composition from disk, or created by one of the functions in Altamira 
Composer.
 
As you'll see, you can move an image anywhere over the void. There are also functions that let you 
move the void within the view window. For example, you can use the Center on Image button to move 
the view so that the current image is in the center of the view window.
 
o Click on the Center on Image button    in the sliders bar below the view window. (It's just to the left
of the color swatch in the center of the sliders bar.)

Result: The image is now in the center of the view window.
Remember, you haven't actually moved the image, only the view.



Adjusting the Composition Guide 

 
You can drag images anywhere on the screen. For example, you might want to move the current image 
away from the composition guide.
 
1. Move the mouse anywhere over the image, hold down the left button, and drag the image to the 
left.
 
Result: A bounding box outline appears, representing the image.
 
2. Release the mouse when the bounding box is near the left edge of the view window.
 
Result: The image is redrawn at the left side of the view window, revealing the composition guide.
 
For this tutorial, you'll create a composition that's the same size as the image of the model. As a result, 
you want to adjust the composition guide to be the same size as the current image. To find out the size 
of an image, plus other information, you simply double-click on the image:
 
1. Double-click on the image of the model.
 
Result: An Image Info dialog box appears.
 
Among other things, you see Dimensions=309x449. This is the width and height of the image in pixels. 
You can use this to change the size of the composition guide:
 
2. From the File menu, select Compositions, and then select Composition Info.
 
Result: The Composition Info dialog box appears.
 
The Composition Info dialog box is almost exactly the same as the New Composition dialog box, except 
that it lets you change your composition settings without erasing the images in your scene.
 
3. Enter 309 in the Width field and 449 in the Height field, and then click on Modify. 
Result: The composition guide is reduced in size.
 
Finally, here's an easy way to place the image accurately over the composition guide:
 
4. Click Home    in the upper tool bar to return the image to its original location.
 
The Home function returns an image to the place it was first loaded or the place it was created. In this 
case, the image of the model was loaded into the upper-left corner of the composition guide, which is 
where it returns. As you'll see later, you can set the Home position of an image to any position you like.



Creating a Locked Background 

 
All of the images in a composition remain floating, so you can move them anywhere at any time. In 
some cases, such as when a large image is used as a background, you don't want to move it 
accidentally. You can prevent any image from moving by locking its position. 
In this tutorial, you'll use the picture of the model as a background and lock its position.
 
1. Click the Lock Position button    in the top tool bar row.
 
2. Try to drag the image.
 
Result: The image is locked in place and you can no longer move it. (Images are unlocked by repeating 
the Lock Position command.)

Note: Images are locked for convenience only. You don't have to lock an image, and any image can be 
used as a background, or you can have no background at all and use the composition guide.



Multiple-Image Libraries 

 
Altamira Composer has a special type of file, called a library file, that contains several images. You use it
when you want to organize and store multiple images, usually of a single category. For example, you're 
going to add a flower to the model's hat. In your composer\libs directory, you'll find a library file of flowers
that you can choose from.
 
1. In the top tool bar, click Open Library.
 
2. Select flowers.all, and then click on OK.
 
Result: Four flowers appear on your screen.
 
Each of these flowers is a separate image. Using the Spline function in Altamira Composer, they were 
cut out of a rectangular picture of a bouquet of flowers. Since each flower is a separate image, you can 
move them anywhere on screen.
 
o Take a moment to drag the flowers into different positions on the screen.
 
Notice that some flowers appear in front of others, while all of the flowers are in front of the model. Each 
image in a composition maintains its own layer position in a stack, from front to back. You can change 
the order of the images in the stack, as we'll demonstrate later.
 
Notice also that only one image is active at any time. This is called the current image. As you move the 
mouse over the current image, its cursor changes to an arrow with a small box to indicate that you are 
over the current image.
 
All of the functions in Altamira composer act on the current image. In most cases, the current image is 
the last image you clicked on. However, when you load an image or create an image, the new image 
becomes the current image.
 
You can always tell which image is current by pressing the Shift key:
 
o Press, and then release the Shift key.
 
Result: A bounding box appears briefly around the current image.



Selection Sets 

 
Sometimes, you want a function to affect more than a single, current image. In such cases, you can 
place two or more images into a selection set. A selection set is a temporary selection of multiple images
that makes all of them the current image.
Most of the functions in Altamira Composer can be applied to a selection set of images. For example, in 
this exercise you want to keep the daisy flower for the model's hat and delete the remaining flowers. 
Rather than deleting them one at a time, you can put them in a selection set, and then delete the 
selection set.
 
There are several methods of selecting images. You've already seen how to select a single image by 
simply clicking on it. You can select multiple images by drawing a box around them, you can select all 
images in the composition by using the Select All command, or you can use the additive selection 
method demonstrated below:
 
1. Click on one of the flowers, other than the daisy.
 
2. Hold down the Shift key.
 
Result: The bounding box appears around the selected flower.
 
3. While pressing the Shift key, click on another of the non-daisy flowers.
 
Result: The bounding box expands to enclose both of the selected flowers. 
Both flowers are now a part of the selection set.
 
4. Still pressing Shift, click on the third non-daisy flower.
 
Result: All three flowers are surrounded by the bounding box.
 
5. Release the Shift key.
 
Note:      If you get carried away and include the daisy in your selection set, click anywhere outside of the
selection set to cancel it, and then repeat steps 1 through 5.
 
6. Click Delete    in the top tool bar row.
 
Result: The three selected flowers are deleted.



Putting the Flower in the Hat 
 
Now that you've got a pair of images, you can begin to create a composition. You'll start by putting the 
daisy in the model's hat.
 
o Drag the daisy to the crown of the hat.
 
It looks pretty good already. The edge of the daisy is clean and smooth against the hat because 
Dynamic Alpha provides an antialiased edge no matter where you place the daisy. You can improve the 
effect, however, by putting the flower behind the brim of the hat. To do this, you make a mask in the 
shape of the brim. You'll use the Spline tool to make the mask.

Move the daisy out of the way, so you can work on the brim of the hat:
 
1. Drag the daisy off to either side of the model image.
 
2. Click anywhere on the model image to make it the current image.



Setting the Spline Options 

 
A spline is a curved image that is created by clicking to set several points, called ducks. After that, you 
edit the spline by moving, inserting, or deleting the ducks before, finally, rendering the spline as an 
image. There are a number of options that you can preset to determine how your splines will be drawn-
filled or unfilled, open or closed, and so on. These are set in the Spline Options dialog box. 
Spline is one of the Geometry tools. You can place all of the Geometry tools on the tool bar by changing 
the 13 swap buttons on the left side of the lower tool bar.
 
1. Right-click anywhere over the tool bars.
 
Result: A pop-up menu appears listing groups of swap buttons.
 
2.  Select Geometry.
 
Result: The 13 swap buttons (the leftmost buttons in the lower tool bar) are replaced by new buttons 
containing Geometry commands.
 
3. Click Spline Options (near the right end of the Geometry swap buttons).
 
Result: The Spline Options dialog box appears.
 
A spline can be filled or unfilled, open or closed; and an open spline can taper so that the start and end 
of the spline change color, size, and opacity. For the masking spline that you'll create, you want a closed
spline that uses all of the current settings in the sliders bar at the bottom of the main screen.
 
4. Click on the Through button, so that the spline runs through the ducks instead of near them.
 
5. Click on the Closed button, and then make sure that the Fill box contains an X. (If not, click in the 
Fill box to place an X.)
 
6. Place Xs inside the Opacity and Closed boxes below Current on the left side of the dialog box. 
This means that the spline will be drawn using the current settings specified by the opacity slider and 
current color swatch in the sliders bar.
 
7. Click on OK to exit the dialog box.



Creating the Spline Mask 

 
In the following steps, you'll use the Spline tool to draw a spline in the shape of part of the hat brim. 
You'll then render the spline using the Texture option. This will copy pixels from the brim to the spline 
image-resulting in a mask image.
1. Press Shift to make sure that the picture of the model is the current image.
 
2. Make sure that the opacity slider on the left side of the sliders bar is set to 100.
 
3. Click Spline    to begin the creation of a spline image.
Result: The mouse cursor changes to an arrow tip.
 
4. Click to set the ducks in the order and placement shown in the following illustration. Set the ducks
carefully along the brim of the hat. The remaining ducks, below the brim, can be almost anywhere.

5. After you've placed the ducks, right-click to display a pop-up menu, and then select Done.
Result: The spline outline remains on the screen. As you move the mouse around the spline, single 
squares appear near the mouse.
 
The small squares are the ducks that you set. You can drag any of them to adjust your spline. You don't 
have to click right on a duck to drag it; you can click anywhere to drag whichever duck is visible.
6. Drag the first duck you placed down slightly, and then adjust the duck to its right, until the top of 
the spline is properly aligned with the brim of the hat. (You don't have to be perfect, Dynamic Alpha will 
give you a clean edge.) For best results, place the edge of the spline slightly below the upper edge of 
the brim.
 
7. Right-click to display a pop-up menu of choices.
 
There are three ways in which you can render a spline or polygon. If you choose Color, the spline 
appears in the current color. If you choose Erase, the spline cuts a hole in the current image, and no 
new image is created. If you choose Texture, The pixels of the current image that overlap the spline are 
copied into the spline.
 
8. Select Texture.
Result: The spline outline disappears, but nothing seems to be created.
 
The spline is there, but you can't see it because it's a perfect copy of the image beneath it, and there's 
no seam at its border because of the smooth, alpha edges. 
Note: If, when performing the above steps, the image beneath the spline is not the current image, the 
spline will be rendered in the current color, regardless of which option you choose. If this should happen,
you can use the Texture Full command among the Textures swap buttons to texture the spline. To do 
this, you would select Texture Full, and then click on the image that's overlapping the spline.



Seeing your results

1. Press Shift briefly to see the bounding box of the spline image.
 
2. Pass the mouse over the image and watch its cursor change to indicate where the current image 
is.
 
3. Drag the spline image to one side so you can see it.
 
4. Click Home    to return the image to its original location.
 
Now that you have a mask image, you can put the flower behind the brim of the hat:
 
o Drag the daisy to the hat.
 
The illusion works because the images are maintained in a layered order and Dynamic Alpha provides a 
smooth edge to the textured mask image. The stack order of the images is correct in this example 
because you loaded the picture of the model first, then loaded the daisy, and then created the mask. 
Images are initially layered from back to front as they are loaded or created.



Creating a Shadow 

 
In the following steps, you'll use five new commands-Duplicate, Color Atop, Wash, Blur, and Erase-to 
create a shadow for the daisy. You'll also take a quick look at the Color Selection dialog box. 
To begin, you'll make a copy of the daisy, and then use the Color Atop command to create a black 
silhouette of the flower.
 
1. Make sure that the daisy is the current image (press Shift).
 
2. Click Duplicate    in the top tool bar to create a copy of the daisy.
 
Result: The duplicate is placed at the front of the stack, so the daisy appears to have jumped to the front
of the brim.



Color Selection 

 
You'll use the Color Atop command to make a black silhouette of the duplicate daisy. First, you need to 
make the current color black. The current color appears in a color swatch in the sliders bar at the bottom
of your screen.
 
1. Click on the current color swatch.
 
Result: The Color Selection dialog box appears.
 
The current color appears in the Current swatch and the changed color appears in the New swatch. You 
can enter colors numerically in the Red, Green, Blue or Hue, Saturation, Value fields, or drag the cursor 
within the color box. You can also adjust your colors by dragging the triangles representing Hue, 
Blackness, and Whiteness.
To create the color black, do this:
 
2. Drag the triangle in the Whiteness column all the way to the top.
 
3. Drag the triangle in the Blackness column all the way to the bottom.
 
4. Click on OK.
 
Result: The current color swatch is now black.



The Color Atop Command 

 
The Color Atop command is one of the Touchup tools. It applies the current color to the non-clear pixels 
in the current image. (Another Touchup command, Color Over, lets you apply color anywhere within the 
bounding box of an image.)
As with all Touchup tools, you can apply the color in one of three ways: using a paintbrush, using a 
brush template, or by applying it to the full image. You select the means of application by clicking on one
of the three applicator buttons in the sliders bar.
In this case, you want to color the entire shape of the daisy, so you'll use the full image applicator.
 
1. Click on the full image applicator button in the sliders bar. (The applicator buttons are to the right 
of the current color swatch.)
 
2. Make sure that the opacity slider on the left side of the sliders bar is set to 100.
 
3. Click Color Atop    (toward the right side of the lower tool bar). 

Result: The daisy turns black.



Positioning the Shadow 

 
Now that you have a shadow, you can position its offset, and place it below the original daisy.
 
1. Drag the black daisy up and to the right about 1/4-inch.
 
2. Click Behind    in the top tool bar, and then click on the original daisy.
 
Result: The shadow is now behind the daisy, but in front of the hat.
 
The Behind tool is one of the stack functions that let you specify where in the stack layer of images you 
want the current image. In this case, after selecting Behind, you click to specify which image you want 
the current image placed behind. Other stack functions let you place the current image up or down, one 
image at a time, or to the front or back of the stack.



Adding Transparency 

 
This would be a more realistic shadow if it were transparent. With Altamira Composer, you have 
complete control over transparency because you have complete control over alpha-which controls 
transparency. Using the Wash command, along with the opacity slider at the bottom of your screen, you 
can reduce the opacity of the shadow image.
 
1. Adjust the opacity slider to 70.
 
2. To access the Wash command, right-click on the tool bars and select the Effects swap buttons.
 
3. Click Wash.
 
Result: The shadow is now partially transparent.
 
The opacity slider affects the amount of Wash applied to the image. A lower number would have made 
the image more transparent. If you're not sure of the amount you want, you can begin with a high 
number, and then repeat the Wash to increase the transparency. In this case, for example, you might 
want the shadow to be more transparent.
 
4. Click Wash again.
 
Result: The shadow appears clearer.



Using Blur
 
You can make the shadow appear out of focus by blurring it. This is simply a matter of applying the 
function to the shadow image.
 
1. Make sure the shadow is the current image. (This is the last time we`ll nag you with this 
reminder.) Just keep in mind that every function is applied to the current image. If you make a mistake, 
click Undo    before proceeding.
 
2. Click Blur.

Result: The Blur dialog box appears.
 
You can blur the pixels horizontally or vertically using the controls in this dialog box.
 
3. Make sure the Horizontal equals Vertical option is checked, enter 4 in the Horizontal value field, 
and then click on OK.
 
Result: The shadow is blurred.
 
Notice that, since every function is applied to the current image, you don't have to worry about masking 
and selection areas. The current image is the selection area. For example, the tips of the shadow are 
sticking up over the top of the hat. You can use the Erase tool with a paintbrush to get rid of them 
without affecting the other parts of the composition. 



Using Erase

Erase is another Touchup tool. It's on the lower tool bar right next to Color Atop. If you'll recall, you used 
Color Atop with a full-image applicator to create the black daisy. This time, you'll use the Erase Touchup 
tool with a paintbrush applicator to localize its effect.
 
1. Click on the paintbrush applicator button to the right of the current color swatch. 
A paintbrush is a small, circular shape that you can drag across the image to apply the Touchup function.
The size of the paintbrush is controlled with the brush size slider, which is the second slider in the sliders
bar. The edge of the paintbrush (soft, medium, or hard) is controlled by the button to the right of the 
brush size slider.
 
2. Set the opacity slider to 100.
 
3. Set the brush size slider to 24 (all the way to the right).
 
4. To the right of the brush size slider is the brush edge button. Click it several times while observing
the black dot in its center.
There are three settings for the brush edge-soft, medium, and hard. With each click, the dot changes in 
size to represent one of these settings.
 
5. Set the brush edge to medium.
 
6. Click Erase.
 
Result: The cursor changes to a small circle.
 
7. Drag the mouse over the portions of the shadow that stick up beyond the crown of the hat.
 
Result: The shadow is erased where you drag the brush.
 
Again, notice that you don't have to worry about accidentally erasing the daisy or the satin background. 
You only affect the current image. (If you accidentally erase too much of the shadow, click Undo, and try 
again.)
 
8. To exit the Erase tool, right-click and select Done, or press Enter.



Adding Text 
 
You might want a title for your composition. Here's how to add text:
 
1. Click Text    in the lower tool bar.
 
Result: The Text dialog box appears.
 
You can use any font in your Windows system. To choose a font, do this:
 
2. Click on the Select Font button to display the Font dialog box. 
The fonts are listed in the window at left. You can scroll through and select any font you'd like to use for 
the composition.
 
3. Click to select a font. (If you have CaslonOpenFace, choose that.)

Result: An example of the selected font appears in the Sample window.
 
You can select from the point sizes at right, or enter a custom point size. For this composition, you need 
a custom size:
 
4. In the Size field, enter 60.
 
5. Click on OK to return to the Text dialog box.
 
6. In the text field at the top of the dialog box, enter: 
DAISY 
 
7. Click on OK.
 
Result: The word "DAISY" appears as an image.



Creating a Ramp 

 
The text appears in the current color, which is black. Using the Texture command, however, you can 
make your text any color or pattern. You'll use the Ramp function to create an image consisting of a 
gradient of colors, and then apply those colors to the text.
 
1. Drag the text image a few inches away from the corner of the view window.
 
Note:    To select the text image-or any image, you must click on the non-clear pixels in the image. Every 
image is a rectangle, as you can see by their bounding boxes when you move or select them. But the 
alpha in some images makes certain pixels transparent. The pixels that do show are the non-clear 
pixels. In the case of the "DAISY" text image, the non-clear pixels define the letters, and the remaining 
pixels are clear. We call the non-clear pixels the shape of the image.
 
2. Click Ramp    in the lower tool bar.
 
Result: The Ramp dialog box appears.

A ramp is a gradient of two or more colors. Using the Ramp dialog box, you can create a rectangular 
pattern with smooth gradients of color across four directions. The four color swatches in the dialog box 
represent the colors of the pixels in the four corners of the rectangle you will draw. 
For this example, you want a two-color gradient, running from yellow at the top, to red at the bottom. 
Begin by changing the upper-left color swatch to yellow:
 
3. Click in the upper-left color swatch.
 
Result: The Color Selection dialog box appears.
 
4. Drag the triangle beside the Whiteness bar all the way to the top.
 
5. Click anywhere in the Hue/Blackness color box (the largest box), and drag the mouse toward the 
yellow area to select a yellow color.
 
The Hue/Blackness box is arranged by hue (color) horizontally, and by blackness vertically. Thus, the 
pure hues run along the top of the box, and then increase in blackness downward. Once you've found a 
yellow that you like, you can adjust its hue by dragging the triangle at the top of the Hue/Blackness box. 
You can increase its blackness by dragging the triangle in the Blackness side of the box, and increase 
its whiteness by dragging the triangle beside the Whiteness column.
 
6. After selecting the yellow, click on OK.
Result: The Ramp dialog box reappears with the new yellow color in the upper-left color swatch.



Selecting more colors for the ramp

Since you want only a two-color ramp, you'll copy the yellow to another swatch:
7. Make sure the Copy option is checked, and then click on the vertical button beside the upper-right
color swatch.
 
Finally, create the red colors for the ramp:
8. Click in the lower-left color swatch.
 
9. Select a red color, and click on OK.
 
10. In the Ramp dialog box, click on the vertical button beside the lower-right color swatch to copy the
red to it.
Result: You should now have four color swatches with yellow in the upper two swatches, and red in the 
lower two.
 
11. Select OK.
Result: The cursor appears, shaped as a corner triangle.
 
12. Drag a box over the "DAISY" text that just covers it in height, but is an inch or so longer in width.
Result: When you release the mouse button, the box outline remains on screen.
 
You're now in box edit mode, which is similar to spline edit mode. Every function in Altamira Composer 
that begins by defining a box, gives you an opportunity to edit the size and placement of the box before 
proceeding. As you move the mouse, handles appear at the sides, corners, and center of the box. You 
drag the handles to adjust the box. When the handle is in the center of the box, you can drag the entire 
box to a different position.
 
13. If necessary, drag the handles to adjust the box. Its height should just cover the text, and its width
should extend beyond the text by about an inch on one side or the other.
 
14. When the box is as you like it, right-click and select Done, or press Enter.
Result: A yellow-to-red gradient box appears.
 
Notice that you don't apply a gradient directly to the text image. In Altamira Composer, all of your raster 
images are treated as objects-including the ramps. Once you've created a ramp image, you can use any
of the Altamira Composer functions to alter the ramp before applying it to another image with the Texture
command (described next). For example if you wanted a diagonal ramp, you would simply rotate the 
ramp image. In this case, however, you'll use the ramp as created. But first, you need to lower it in the 
stack so you can see your text image:
 
1. Click Lower to place the ramp image one layer toward the back of the stack so the "DAISY" 
image appears.
2. Click to select the text image.





Using the Texture Command 

 
You'll use the Texture command to copy the ramp to the text image. The Texture command works very 
much 
like the Texture option that you used previously when you created your spline mask. It copies the pixels 
from a selected, overlapping image into the current image.
 
1. Click Texture    in the lower tool bar, and then click on the ramp.
 
Result: "DAISY" is textured, and seems to disappear.
 
Again, the text image is still there, but since it's now identical with the ramp image, you can't see it.
 
2. Drag the ramp image away to reveal the newly ramped text image.
 
3. Click Delete    to delete the ramp image.



Aligning Images 

 
There are several Align commands that let you align two or more images in various ways. You can use 
two of them to align the text image with the bottom center of the background image.
 
1. From the swap buttons, select Align.
 
2. With the text image current, click Align Centers , and then click on the background image.
 
Result: The text image is aligned to the center of the background image.
 
3. Click Bottoms , and then click on the background image.
 
Result: The text image is moved to the bottom of the background image.
 
You can also move an image using the cursor arrow keys. This is especially handy for precise image 
placement. As a default, the current image moves one pixel at a time when you press the cursor arrow 
keys, and 10 pixels at a time when you combine the Ctrl key with the cursor arrow keys. 
The default settings for the cursor-key offsets are maintained in the Options menu, just like the Spline 
options that you set earlier. Each time you adjust these options, they remain in effect until the next time 
you change them.
 
Check to see that the current cursor-key offset is the default setting:
 
1. From the Options menu, select Edit Options.
 
2. In the resulting dialog box, select Small Cursor Key Offset, and then click on the Default button.
 
The Small Cursor Key Offset is the distance the image will move when you press the cursor key. The 
Large Cursor Key Offset is the distance it will move when you use the cursor key with the Ctrl key.
 
3. Select Large Cursor Key Offset, and click on the Default Value button to set it to 10 pixels along X
and Y.
 
4. Click on OK to exit the Edit Options dialog box.
 
Now, move the text image up:
 
5. Hold down the Ctrl key and press the up cursor arrow three times.
 
Result: The "DAISY" text moves up from the bottom of the background image.



Automatic Drop Shadow 

 
There's an Effects function that automatically adds a drop shadow to images. You can use it here to 
make the text stand out. First, you'll check that the options for the drop shadow are set to default:
 
1. In the Options menu, select Tools Options.
 
Result: The Tools Options dialog box appears.
 
There are three options you can set for your shadow: color, offset, and opacity.
 
2. From the list at left, click to select Shadow Color, and then click on the Default Value button.
 
3. Find Shadow Offset and Shadow Opacity, and set them to their default values.
 
4. Click on OK.
 
Now, apply the drop shadow to the text:
 
1. Right-click on the tool bars, and select the Effects swap buttons.
 
2. Click Shadow    to shadow the text.
 
Result: A semi-transparent drop shadow appears under the text.
 
Earlier, you went through several steps to create a drop shadow for the flower in the hat. Why bother, 
you might ask, when you can simply click a button to create a drop shadow? Well, the shadow you've 
just created for the text is part of the raster image. If you attempt to Blur it or Wash it, for example, all of 
the image will be altered, including the text. Also, since the flower's shadow is still a separate image, you
can still adjust its position in relation to the flower. The text drop shadow, on the other hand, is locked to 
the text. 
There are advantages to both shadowing techniques. One is faster, and the other is more flexible. For 
the 
greatest flexibility in Altamira Composer, build your compositions with many separate images. Later, you 
can convert a group or selection set of images into a single raster image with the Collapse command . 
But once you've collapsed a group, you can no longer affect its isolated images without affecting the 
whole image.



Going Home 

 
You've seen how the Home command sends an image back to the position at which it was created (or 
loaded). Using the Remember command, you can specify any position on screen as the image's home. 
For example, of the images that make up your composition, the background, the flower, the flower-
shadow, and the text images are no longer in their home positions. Only the mask image (remember the 
mask image?) is in its home position where you created the original spline. 
Let's say you're satisfied with your composition as it stands. You might want to fiddle with it later-adjust 
an image here and there-but you don't want to forget the current position of the images. Here's how to 
reset the home positions for all of the images:
 
1. Click Select All    in the top row of the tool bars. 

Result: All images are selected as current.
 
2. Click Remember    in the top row of the tool bars.
 
Result: The home positions of all of the images are reset to their current positions.
 
Now, you can prove that each of the images has a proper home. But first, you must deselect the set of 
images. When images are selected, you need to click outside of the selection set before you can 
reselect a single image.
 
o Click on the void, outside of the images.
 
Note: The void is the area of the screen that you see behind your images. Much of it is gray, and it 
includes a rectangle of another color called the composition guide.    For now, all you need to know is 
that the void is somewhat like the Windows desktop. You can move images over it, but you can't paint on
it or otherwise alter it.
 
And now, move the images away from the background:
 
1. Select the text image, and drag it off to the left.
 
2. Repeat the process with all of the remaining images (except for the background image, which is 
locked in place). Drag the flower, flower-shadow, and mask images off to the left and right sides. You can
see that the original picture of the model is untouched. One of the nice things about working with a 
composition is you don't have to alter your original images. You can create a completely different picture 
using a collection of images. Because of Dynamic Alpha, all of the edges are perfectly anti-aliased, and 
there are no seams.
 
Now, restore your composition by sending all of the images home:
 
3. Click Select All, and then click Home. 
Result: The images fly to their home positions, restoring the composition.





Saving a Composition 

 
In the full version of Altamira Composer, at this point, you would use the following steps to store your 
current collection of images to disk as a new composition:
 
1. Right-click on the tool bars and select the Compositions swap buttons.
 
2. Click Save Composition As.
 
Result: A file dialog box appears.
 
3. Enter a filename, and then click on OK.
 
Result: The current composition is stored on disk.
 
As you continue to edit and change your composition, you can select Save Composition to resave new 
versions of the composition under the same filename. If you wanted to create a new version of the 
composition with a different filename, you would select Save New Composition again.



Clearing a Composition 

 
Before proceeding, here's how to clear all of your images from the screen and start with a clean screen, 
do the following:
 
1. Click New Composition.
 
2. In the resulting dialog box, leave all of the settings as they are, and click on OK.

Result: The screen is cleared of all images.
 
Here's another way to clear all of the images from your screen without beginning a new composition:
 
1. Click Select All.
 
2. Click Delete.



Tutorial 2

A Celtic Amulet

The ancient Celts created intricate, interlaced designs that are still seen today in jewelry and tapestries. 
This next tutorial results in an image that looks very much like a Celtic amulet. Along the way, you'll 
explore many new features in Altamira Composer.

In the course of the tutorial, you'll create a ring shape, highlight it with the Ramp tool, and then apply 
shading and stippling to it. You'll then see how to interlink three copies of the ring, and finally apply a 
warp for the finished design.

A Ring Shape

You'll begin by creating a simple ring, or donut shape. This will become the foundation for the final 
image.

1. Start with a blank composition window. In the sliders bar at the bottom of your screen, set the 
opacity slider to 100, the brush-size slider to 24, and the brush edge button to hard.

2. Click on the current color swatch, select a color such as a light blue, and then click on OK.

3. Right-click on the tool bars, and select Geometry.

You'll draw an ellipse in the current color. To force the Ellipse tool to a circle, you hold down the Ctrl key 
while creating the ellipse.

4. Select Ellipse , hold down the Ctrl key, click toward the upper-left corner of the screen, and drag 
down and to the right to define a box 250 pixels square. The numbers in the parentheses in the status 
bar should read:    (250 250).

5. Press Enter to render the circle.

Result: A blue circle is drawn on the screen.

Rather than dragging the image to the center of the view window, by using one of the buttons in the 
sliders bar, you can automatically pan the view so that the current image is in the center of the window:

6. Click on the center-on-image button    in the sliders bar. (It's to the left of the current color swatch.)

Result: The view is panned so that the circle is in the center. (Remember, the image didn't move, the 
view through the window did.)



You'll next punch a hole in the circle by duplicating it and using the Snip command.

1. Click Duplicate    to create a second circle.

Now change the color of the duplicate circle so you distinguish it from the first circle:

2. Click the current color swatch and change the current color to black. (Drag the Blackness triangle 
to the bottom, and the Whiteness triangle to the top.)

3. Select the full-image applicator button in the sliders bar, and then click Color Atop , at the right of 
the lower tool bar.

Result: You now have a black circle on top of a blue circle.

4. Right-click on the tool bars, and select Transforms.

5. Click Scale    in the swap buttons, and drag the mouse to reduce the bounding box of the black 
circle to 70 percent of its size. The status bar should read: % 70 70 (70 70). 

6. Right-click and select Done to scale the circle.

Result: You now have a small black circle inside a larger blue circle.

The Snip tool lets you erase the current image by using the shape of a second, overlapping image. In 
this case, the blue circle will be the current image, and you'll snip a hole in it with the black circle.

7. Click to activate the blue circle.

8. Right-click on the tool bars, and select Textures.

9. Click Snip , and then click on the black circle.

10. Drag the black circle out of the way, and then delete it. (You can quickly delete an active image by
pressing the Delete key.)

Result: You now have a blue ring shape.

Creating a Ramp Highlight

In the previous tutorial, you used the Ramp command along with the Texture command to apply a 
gradient of color to the "DAISY" text. Here, you'll use the same two commands, along with some others, 
to create a metallic effect.



1. Click Ramp    in the lower tool bar.

Rather than create a ramp, you can select a stored one from the Color Set menu:

2. In the Ramp dialog box, click on the arrow to the right of the Color Set pop-up menu, and select 
white->black from the list of stored color sets.

Result: The ramp colors now consist of two whites and two blacks.

3. Click on OK, and then drag a ramp box that slightly more than covers the right half of the ring.

4. Edit the box, if necessary. Right-click and select Done, or press Enter to render the ramp.

You now have a ramp image that runs from white to black. You can use any of the Altamira Composer 
commands to manipulate your ramp before applying it to another image. In this case, you'll create a 
mirrored ramp.

1. Click Duplicate    to create a second ramp.

The Permute commands let you flip, rotate, or shift the pixels of an image. You'll use one of them to flip-
or mirror the duplicate ramp:

2. From the swap buttons, select Permutes.

3. Click Flip Right-Left .

Result: The duplicate ramp now runs from black to white.

Next, you'll use one of the Align commands to align the edges of the two ramps.

4. Drag the new ramp directly to the left until there's about a 1/4-inch gap between the two ramps.

5. From the swap buttons, select Align.

6. Click Abut , and then click on the original ramp image, to the right.

Result: The current ramp is moved so that its right edge is perfectly aligned with the left edge of the 
other ramp.

The top and bottom edges of the ramps should be approximately even, but they don't have to be perfect.
Nevertheless, here's how to align them:



7. Click Tops , and then click on the rightmost ramp.

Result: Both ramps are now perfectly aligned.

Together, the two ramps provide a cylindrical, metallic effect. This is exactly what you want to apply to 
your ring shape. Since the source image used by the Texture command must be a single image (you 
can't use a grouped image), you must make both ramps into a single image before texturing the ring. As 
you may recall from the previous tutorial, the Collapse function will do this.

First, put the ramps in a selection set:

1. Hold down the Shift key to display the bounding box around the leftmost ramp.

2. While still holding the Shift key, click on the other ramp to add it to the selection set, and then 
release the Shift key.

Result: The bounding box increases to include both ramps.

3. Click Collapse    to make a single raster image of the two ramps. (The Collapse icon is in the left 
third of the upper tool bar.)

To make it look like the highlights are coming from an angle, you'll need a diagonal ramp. This is simply 
a matter of rotating the ramp image:

1. From the swap buttons, select Transforms.

1. Click Rotate , and drag the mouse to the right to rotate the ramp approximately 45 degrees. The 
status bar should read: angle: 45 (45).

2. Right-click, and select Done.

Result: After a moment, the ramp image is rotated.

Now, texture the ring with the ramp:

1. Click To Back    to place the ramp behind the ring.

2. Click to activate the ring image.

3. Click Texture    in the lower tool bar, and then click on the ramp.

4. Click on the ramp to activate it, and then click Delete    (or press Delete) to remove the ramp.



Result: The ring now looks somewhat metallic.

Shading the Ring

To make this ring look truly three-dimensional, you need to add shading to the edges. If you were very 
careful, you could paint the edges darker, but it would be a difficult and laborious task, at best. Instead, 
you'll create an inverse image of the ring in black, offset and blur the black image, and then use Texture 
to apply it to the ring.

You'll use the Complement Shape function to create a reverse image of the current ring shape. For this 
effect to work, you'll need a larger bounding box around the ring so that the new image will have a 
border. You can use the Extend Image command to enlarge the current bounding box.

1. Press Shift briefly to see the size of the current bounding box.

Result: The bounding box just covers the size of the ring.

2. From the Edit menu, select Extend Image, and then drag a box that's at least 1/4-inch larger than 
the ring.

3. Right-click and select Done, or press Enter to complete the process.

4. Press Shift again to see the size of the new bounding box.

Result: The bounding box now extends beyond the ring.

As you'll discover when you use composer, every image contains alpha data that affects the 
transparency of its pixels. Each image is really a rectangle, but the alpha transparency makes it appear 
as if you are manipulating irregular shapes. For example, the ring image is really a rectangle with 
opaque pixels in the shape of a ring, and clear pixels that provide the hole, and the curved outer part of 
the ring. The bounding box that you see when you move the image or press Shift is the true dimension 
of the image.

The non-clear pixels in an image are called the shape of the image. When we say this image is ring-
shaped, we are saying that its non-clear pixels are arranged in a ring pattern. For this tutorial, you 
should understand that the Complement Shape function creates a new image that inverts the opacity of 
the current image. Thus, all of the pixels that are currently opaque will become clear, and all the 
remaining pixels will become nonclear and use the current color (in this case, black).

Enough theory! Let's do it:

1. Click Complement Shape    in the middle of the lower tool bar.

Result: All of the clear areas in the ring appear to turn black.



The black is actually the new image. You can see this by dragging it to the side:

2. Drag the black image off to the right slightly.

The new image is a perfect representation of the clear pixels created by the alpha in the original, ring 
image.

By offsetting and blurring this image, you can texture it onto the ring to create an effective, airbrush 
effect.

1. Click Home    to send the inverted image to its original location.

2. Drag the inverted image about 1/8-inch up and to the right of the original ring image.

3. In the top tool bar, click Blur , set both Horizontal and Vertical to 12 pixels, and then click on OK.

Result: After a moment, the inverted image becomes blurred.

You want to texture the blurred image onto the ring, so you need to activate the ring image. Since it's 
pretty much covered by the inverted image, you'll find this hard to do by simply clicking on the ring. 
Instead, you can use the Tab key. The Tab key works similarly to the Shift key in that it displays the 
bounding box of the current image. However, with each press of the Tab key, it activates and displays 
the bounding box of the next image in the stack. Thus, by repeatedly pressing Tab, you can activate 
each image in a composition. In this case, there are only two images in the composition, so it shouldn't 
be hard to activate the ring image.

4. Press Tab repeatedly while watching the display of the bounding boxes. The bounding box of the 
ring will be lower and to the left. When it's displayed, release the Tab key.

Now, texture the ring:

5. Click Texture , and then click on the black, inverted image.

6. Click to activate the black image, and then delete it.

7. Click Bounding Box Crop    in the upper tool bar to reduce the ring's bounding box to the size of its
shape.

Result: Your image now looks like a true, three-dimensional ring.

Color Mapping

The ring looks a little "clean" right now; let's rough it up a bit. You can use one of the noise patterns 
along with the Color Map function to make the ring look pitted.



Among the Patterns functions is the Gray Noise button. This creates an image with random gray pixels. 
The noise patterns are effective in adding a stippled look to your images.

1. From the swap buttons, select Patterns.

2. Click Gray Noise .

3. Create a box that completely covers the ring, and then press Enter to ren-der it. (Enter is the key 
alternative to right-clicking and selecting Done.)

Result: A rectangular image appears that's covered with random gray pixels.

4. Click To Back    to send the gray pattern behind the ring.

The Color Map function is similar to the Texture command, except that it copies the color values from the
source image while maintaining the intensity values of the current image. (There's also an Intensity Map 
function that does the reverse. It copies the intensity from a source image and maintains the color in the 
current image.)

You're probably looking at the two images on your screen and thinking, What color values? It's true that 
both images are shades of black, white, and gray. However, what you want to do here is maintain the 
intensity values of the ring-the shadows and highlights that you worked so hard to create. And you want 
to transfer only the colors (in this case speckled gray pixels) from the noise image.

There's a Tools option that determines the amount that the colors affect the intensity. Check to make 
sure it's set to its default value:

1. From the Options menu, select Tools Options.

2. Select Intensity Map Threshold, click on the Default Value button, and then click on OK.

Now, bring up the Color Map icon, and perform the mapping.

3. From the swap buttons, select Textures.

4. Click to activate the ring image.

5. Click Color Map , and then click on the gray noise pattern.

6. Click again on the gray noise pattern, and then delete it.

Result: The ring is covered with random, gray pixels, but the intensity values that give depth to the ring 
remain.



Saving the Ring

You've completed the ring; the rest will be easy. Before proceeding, you'll need this ring later, so you'd 
better save it to disk as an image. 

1. From the File menu, select Images, and then select Save Image As from the submenu.

2. In the file dialog box, make sure that the Write Alpha option is checked.

Important:    If the Write Alpha option is not checked when you save your image, all of the alpha data is 
saved as a solid color, as specified by the Composition Guide Color option (default is gray). Thus, when 
you reload your ring image, it would be a gray square with a ring on it.

3. Enter a filename, such as myring, and then click on OK.

Linking Rings

The next steps are relatively easy, but very effective. You'll create duplicates of the ring, arrange them 
into three overlapping rings, and then use a special technique to make them appear as if they're 
interlinked.

1. Drag the ring toward the top center of the view window.

2. Click Duplicate    twice to make two copies of the ring.

3. Drag the front copy of the ring down and to the left slightly, and then drag the second copy down 
and to the right.

Once you have your three rings the way you want them, save the composition so you can return to this 
point, if necessary:

1. From the File menu, select Compositions, and then select Save Composition As from the 
submenu.

2. Enter a filename, and then click on OK.

Now, create a new ring, and then store all the positions:

1. Click to activate the uppermost ring (the original ring that's at the back of the stack).

2. Click Duplicate    to make a copy of the ring.



Result: The duplicate appears at the front of the stack of rings.

Store the current positions of all the rings:

3. Click Select All , and then click Remember .

4. Click on the void away from the rings to cancel the selection set, and then click on the new ring to
select it.

Note:      When you click on the new ring, the bounding box should surround only the ring. If the bounding
box surrounds all the rings, you haven't successfully deselected the set. Repeat step 4, while clicking far
away from the set of rings.

Now comes the magic:

1. Click on the paintbrush applicator button in the sliders bar.

2. Select Erase    from the lower tool bar.

3. Paint over a portion of the right side of the new ring, where it overlaps the rightmost ring. 
Continue painting until you completely reveal the ring beneath it, which now appears to overlap the top 
ring.

Notice that you don't have to be particularly careful while erasing. What you're actually doing is erasing 
only the front ring and revealing both the rightmost ring below it, and the original ring below that. 
Because of the alpha anti-aliasing in Altamira Composer, there are no visible seams between the erased
portions of the front ring and the original ring.

Now, complete the illusion:

4. Erase the portion of the ring where it overlaps in the center of the three 
rings.

5. Right-click, and select Done to exit the Erase tool.

Result: Your three rings should look interlocked.

To see what you've really been doing, move the ring out of the way:

6. Drag the current ring off to the side.

Result: It's erased in two areas.



7. Click Home    to return the ring to its original position.

Now that you've got three interlaced rings, you'll collapse them into a single image for one last effect.

o Click Select All , and then click Collapse    to make the multiple images a single raster image.

Note: If you want to save the three rings as an image, use Save Image As .

Completing the Amulet

The Warp functions provide the step that turns the three rings into a special image. And it's the easiest 
step of all.

1. From the swap buttons, select Warps.

2. Click Warp Options in the swap buttons . Select Mesa, click on Default Value, and then click on 
OK.

Like the Touchup tools, many of the Warps can be applied using either the paintbrush, brush template, 
or full image applicators. For this, you'll apply the warp to the full image:

3. Click on the full-image applicator button in the sliders bar.

4. Click the Mesa button in the tool bars.

Result: After a moment, the rings are warped into a bulging pattern.

As a final touch, add a ring to the top of the amulet. You can use the original ring that you saved earlier 
in the tutorial.

1. Select Open Image    from the top tool bar.

2. Select the ring image that you saved, and then click on OK.

3. From the swap buttons, select Transforms.

4. Click Scale , and then scale the ring down 50 percent. The status bar should read: % 50 50 (50 
50).

5. Drag the ring so that it's over the upper loop of the amulet. (Move the amulet down, if necessary.) 
The bottom of the ring should be just below the bottom of the loop.



6. Click To Back    (or press PgDn) to place the ring beneath the amulet.

7. Click Duplicate    to make a copy of the ring.

You'll now use the same technique you used before to create the interlocking rings.

8. Click on the paintbrush applicator button in the sliders bar, and then select Erase .

9. Drag the brush size slider to a setting of approximately 12 pixels.

10. Erase the duplicate ring on one side to reveal the amulet loop.

11. Right-click, and select Done to exit the Erase tool.

Result: Your amulet is complete.

Suggestion: Collapse and save the completed amulet and then experiment with the functions you've 
learned in this tutorial. For example, you might reload the original three linking rings and try different 
warps on them. The technique you used to shade the ring is particularly effective with text. Find a thick, 
curved font and create a text image with a medium color, such as red. When you complement the 
shape, use as your current color a darker value of the red for your shadow. After applying the shadow, 
repeat the whole process with a lighter value of red and offset the complemented shape in the opposite 
direction to create a highlight. Experiment with Color mapping and Intensity mapping to see the 
difference. Try them both with different threshold values.



Quickies

By now you should have a pretty good grasp of the basic operation of Altamira Composer. These next 
tutorials are three short exercises that demonstrate Altamira Composer techniques without going into a 
lot of theory.

Note: These exercises assume that the various settings in the Options menu are at their default values.



The Tube

Here's a way to create a three-dimensional, hollow tube:

1. Click Select All , and then Delete    to clear the screen of any images.

2. Use the Ramp tool    with a white->black color set, and draw a rectangle.

3. From the swap buttons, select Enhance, and then select Compensation.

4. Drag the Shadow/Highlight Control dialog box out of the way so you can see both it and the ramp 
image.

5. In the window at right, drag the middle box handle up and the rightmost box handle down until the
line looks somewhat like a letter N.

6. Click on Preview. 

If necessary, continue adjusting the box handles and clicking on Preview.

7. Enter the word cylinder in the text field, and then click on Save. (This will let you reuse this setting
any time you need a cylinder.)

8. Click on OK to complete the process.

Now, add the two ends of the tube.

1. From the swap buttons, select Geometry.

2. Using any color as your current color, select Ellipse , and draw a box in the center of the ramp 
image.

3. Adjust the right and left sides of the ellipse box so they're right over the edges of the ramp image, 
as in the previous illustration, and then right-click and select Done to render the ellipse.

Result: An ellipse appears over the ramp image.

4. Make sure the opacity slider is set to 100.

5. Select Texture , and then click on the ramp image.



Result: The ellipse seems to disappear.

6. Click on Duplicate    to make a copy of the textured ellipse.

7. Hold down the Ctrl key and repeatedly press the down-arrow cursor key until the current ellipse 
image appears at the bottom of the ramp image. Release the Ctrl key, and use the up and down arrow 
keys to position the ellipse vertically until it's centered over the bottom edge of the ramp image.

Result: The ramp and ellipse look like the lower part of a cylinder.

8. Press the Tab key repeatedly until the bounding box of the other ellipse 
(the one in the middle of the ramp image) is current.

9. From the swap buttons, select Permutes, and then click on Flip Right-Left 

10. Use Ctrl plus the up and down arrow keys, and then the arrow keys with-out the Ctrl key to move 
the ellipse up to the top of the ramp.

You now have a tube. If you wish, you can place all of the images in a selection set, and then use 
Collapse    to make a single image. Or, you might want to use Dodge-Burn    with the applicator buttons 
set to full image to darken the flipped ellipse.



Sparkle

The Ellipse tool is the foundation for a sparkle effect that you can use to highlight text, or metallic 
images.

1. Clear the screen of any images, and then select white as your current color.

2. From the swap buttons, select Geometry.

3. Select Ellipse , and then draw a long, thin vertical box approximately 5 by 240 pixels. The 
numbers in parentheses in the status bar should be: (5 240)

4. Right-click, and select Done to render the ellipse.

Result: The ellipse appears as a thin, white line with tapered ends.

5. Click Duplicate , select Permutes from the swap buttons, and then 
click on Rotate Right 90 .

Result: You now have a cross of tapered ellipses.

6. Click Select All , click Collapse , and then click Duplicate .

7. From the swap buttons, select Transforms, and then click Rotate .

8. Rotate the copied cross 45 degrees.

9. Click Scale    and scale down the copied cross about 70 percent.

Now, add some flare in the center:

1. From the swap buttons, select Geometry.

2. Click Ellipse , hold down the Ctrl key, and draw a small box about 25 pixels square. (Watch the 
status bar.)

3. Right-click, and select Done to render a small, white circle.

4. From the swap buttons, select Align. Click Centers , and then click on either of the crosses to 
move the circle to the center of the crosses.



5. Click Blur , set the horizontal and vertical amounts to 10 pixels, and 
then click on OK.

Let's say this is a sparkle on a diamond. Here's a way to add a subtle touch of color.

1. Click Select All , and then click Collapse    to create a single image.

2. Click Ramp . Set the two leftmost color swatches to white, and the two rightmost color swatches 
to light blue. (We suggest an RGB setting of 140,150,255.)

3. Click OK, hold down the Ctrl key, and the draw a box that's slightly larger than the sparkle. (About
250 pixels square.) Press Enter to render the ramp.

4. Click To Back . From the Align swap buttons, click Centers , and then click on the sparkle to 
center the ramp behind the sparkle.

5. From the swap buttons, select Warps. Select the full image applicator but-ton in the sliders bar, 
and then click Radial Sweep    to create a circular ramp.

6. Click on the sparkle image, click Texture , and then click on the ramp.

7. Drag the ramp out of the way and delete it.

8. Save your sparkle image.

Suggestion: You can adjust many of the elements of the sparkle by using ellipses of different thickness 
and length, and by adjusting the size and blur of the central flare. In addition, you can apply wash to the 
central flare if it seems too opaque. Another thing to try is to create a circular ramp that runs from white 
in the center to gray or black at the perimeter, and then use this ramp as a source to apply Xparency 
Map to the sparkle.



Easter Egg

Try this combination of tapered Spline, Tile, Warps, and Intensity Map to create an Easter egg.

Start with a purple circle:

1. Clear all images from your screen, click on the current color swatch, and select a deep purple 
color (RGB: 40,0,50).

2. From the Geometry swap buttons, select Ellipse , hold down the Ctrl key, and draw a circle that's 
slightly more than a third the size of your screen.

3. Press Enter to render the purple circle.

Now you'll use an open, tapered spline to create a squiggle that's the foundation of the tiled pattern.

4. Click Spline Options    to display the Spline Options dialog box.

5. Set the options in the dialog box as follows: 

o Activate Through, Open, and Taper. Granularity should be 30.

o Set the Start Conditions Width to 5.0, the Opacity to 100, and the Color to red.

o Set the End Conditions Width to 1.0, the Opacity to 20, and the Color to yellow.

o Turn off all of the Current check boxes.

6. Click on OK to exit the dialog box.

7. Click Spline . Anywhere over the circle, set three ducks in a small, comma shape that's about 3/8-
inch overall, depending on the resolution of your monitor.

8. Press Enter twice to render the spline.

Now, use the Tile command to apply a pattern to the circle:

1. Click to activate the circle.

2. From the swap buttons, select Textures, click Tile , and then click on 



the spline comma.

Result: The comma is tiled throughout the circle.

Next, you'll alter the comma slightly and tile the circle again.

1. Click to activate the spline comma. (If you can't find it, press the Tab key until its bounding box 
appears.)

2. From the swap buttons, select Permutes. Click Flip Up-Down , and then Flip Right-Left .

Result: The comma is flipped two ways.

3. From the swap menu, select Effects, and then click Complement Color 

Result: The comma changes to cyan-blue.

4. From the swap menu, select Textures. Click on the circle, click Tile , and then click on the comma.

5. Select the comma and delete it.

6. From the swap menu, select Warps.

7. Click to activate the circle.

8. Click Star Disk , and then press Enter.

You'll use Intensity Map with a circular gradient to add depth the circle.

1. Click Ramp , select the white->black ramp, and then click on OK.

2. Hold down the Ctrl key and draw a box that's larger than the circle by about 1/4-inch on each 
side. Press Enter to render the ramp.

3. Turn on the full image applicator button in the sliders bar. From the Warps swap buttons, click 
Radial Sweep    to create a circular ramp.

4. Click To Back , and then drag the circle so it's over the lower-left portion of the circular area of the
ramp.



5. From the swap buttons, select Textures.

6. Click Tools Options . Select Intensity Map Threshold, set it to 90, and then click on OK.

7. Make sure the circle is active, click Intensity Map , and then click on the circular ramp.

Result: The circle takes on the shadows and highlights of the ramp.

So far, you've got a Christmas tree ornament. Here's how to create an Easter egg:

1. Delete the circular ramp and activate the circle.

2. From the swap buttons, select Transforms.

3. Click Bilinear    and drag the upper two control squares upward and inward to create a trapezoid.

4. Right-click, and select Done to transform the circle.

Result: The circle is now egg-shaped.

The Start Disk warp has blurred the pattern slightly. Here's how to bring it back "in focus."

1. From the swap buttons, select Enhance.

2. Click Sharpen . 

Note: Transforms automatically apply sharpening to the transformation matrix to avoid blurring.




